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Question
What are document templates? State the purpose  of using document template.



AnswerAnswer
Templates or document templates refer to a sample  fill-in-the-blank document that can help in saving  time.
Usually templates are customized documents  that may have sample content, themes, etc. For  example, if you
want to create a resume you can  use a resume template and modify only the sections  that require changes. 



Question

Describe the importance of attention in improving  the effectiveness of communication.



AnswerAnswer
To ensure effective communication, the receiver's  attention should be focused to the message. People
differ in their behavior, attention, emotions, and  so on, therefore they may react differently to the  message.
Subordinates should behave similarly to  the message's content. The actions of superiors also grab the
attention of subordinates, who can then  follow what they see. For example, if a supervisor  is exceptionally
punctual in arriving at work,  subordinates will develop similar behaviors. As the  saying goes “action speaks
louder than words”. 



What are the 7 C’s of effective communication? 

Question



AnswerAnswer
The 7 C’s of effective communication are: 

(i) Conciseness

(ii) Coherent

(iii) Concreteness

(iv) Clarity

(v) Courtesy

(vi) Correctness

(vii) Completeness



Explain any four measures to overcome barriers. 

Question



AnswerAnswer
The four measures to overcome barriers are  discussed below: 

(i) Be prepared before communicating: We are  frequently unprepared to communicate a  message
because we lack sufficient information or  knowledge of what we wish to communicate. At  times, we do not
exhibit the expected behavior of  the communication's receiver.  

(ii) Give sufficient time: The message should not  be communicated too quickly, especially if it is  oral. If it is
not done at the appropriate speed, the  receiver may miss essential points or not grasp it  at all. Thus, group
oral communication, such as  speeches, debates, or group discussions, must be  done at a measured rate
so that the entire audience  understands what is being said.  



(iii) Simplify the language: Both the sender and the  recipient of the communication must be fluent in  the
language in which they communicate. If this  is not ascertained, it is preferable to use simplified  language
with simple words and ideas.  

(iv) Avoid making judgements: Communication can  fail if the message sent passes some judgement on  the
receiver, because the communication's content  is not comprehended in its true sense. It makes the
recipient defensive, resulting in the formation of a  barrier. So, these circumstances must be avoided.



Explain the eight parts of speech with suitable  examples.

Question



AnswerAnswer
According to their function in a sentence, English  language has following eight parts of speech:  

(i) Nouns are words used to describe people, places,  animals and things.  
For example: I have a car.  

(ii) Pronouns are words that are used to replace nouns  in sentences.  
For example: I hurt myself yesterday when I was  playing football.  

(iii) Verbs are words that describe an activity which  is being performed by the noun or subject in a
sentence.  
For example: He plays cricket every day.  

(iv) Adverbs are words that convey more information  about verbs, adjectives, and other adverbs in a
sentence.  
For example: Maya reads the newspaper everyday.  



(v) Adjectives are words that are used in sentences to  describe or provide additional information about  the
noun or subject.  
For example: The black dress you wore on your  birthday was lovely.  

(vi) Prepositions are words that connect one element of  a sentence to another. It indicates the position of
an  object or subject in a sentence.  
For example: Before we could get home, the  burglars leaped over the wall and fled.  

(vii) Conjunctions are words used to join two different  elements of a sentence, phrases, or clauses.  
For example: Jane did not go to work as she was  unwell.  

(viii) Interjections are words that express powerful  emotions or feelings.  
For example: OH! That is very unfortunate. 
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What is the importance of self-regulation in life? 

Question



AnswerAnswer
Some reasons why self-regulation is important are  mentioned below: 

(i) Better decision-making: Self-regulation enables  us to weigh the advantages and
disadvantages of  various options, consider their potential outcomes,  and make an informed
decision.  

(ii) Increased productivity: Self-regulation enables us  to maintain our attention on our objectives
while  avoiding distractions. By putting tasks in order of  importance and urgency, it helps us
manage our  time efficiently.  

(iii) Better relationships: Self-regulation enables us  to control our feelings and communicate
more  effectively in social settings. It makes it possible for  us to actively listen, respond correctly,
and settle  disputes in a positive way. 



Distinguish between internal self-awareness and  external self-awareness.

Question



AnswerAnswer



What are the skills necessary for independent  working? Explain any two.

Question



AnswerAnswer
The skills necessary for independent working are:  

(i) Time management: Time management is a skill  that independent workers must possess in order to

prioritise tasks and meet deadlines. This involves  being able to schedule time effectively, plan and  organise

workday, and use calendars and to-do lists  as tools to help stay on task.  

(ii) Self-motivation: Independent workers must have  the drive and self-motivation to succeed. In order  to do

this, they must set goals, maintain focus, and  find ways to stay motivated despite obstacles or  setbacks. 



What are the advantages of the ability to Work  Independently?

Question



AnswerAnswer
The advantages of the ability to Work Independently:  

(i) Ensures greater learning.  
(ii) Individuals feel more empowered and responsible.  
(iii) It provides flexibility to choose and define working  hours and working mechanisms.  
(iv) Failure and success of the task assigned are  accounted by individuals.  
(v) Individuals become assets to organizations, groups  and nations at large.  
(vi) It ensures creativity and satisfaction amongst  individuals 



What are the drawbacks of self-motivation?

Question



AnswerAnswer
While self-motivation can be a powerful tool for  achieving personal and professional goals, there are  also
potential drawbacks to relying solely on selfmotivation. Some of these drawbacks include:  

(i) Lack of External Accountability: When relying  on self-motivation, there may be a lack of external
accountability to ensure that goals are being met.  This can lead to a lack of consistency and discipline  in
pursuing goals, as there may be no consequences  for failing to follow through.  

(ii) Burnout and Overexertion: Self-motivated  individuals may be more prone to burnout and  overexertion,
as they may push themselves too hard  in pursuit of their goals. This can lead to physical  and mental
exhaustion, and may ultimately hinder  progress towards goals.  

(iii) Limited Resources: Self-motivated individuals may  have limited access to the resources and support
needed to achieve their goals. Without external  support or resources, self-motivation may not be  enough to
overcome challenges or barriers to success. 



(iv) Self-Doubt and Procrastination: Even with strong  self-motivation, individuals may still experience  self-
doubt or procrastination when faced with  difficult or intimidating tasks. This can lead to a  lack of progress
towards goals, as individuals may  avoid taking action or become discouraged by their  perceived lack of
progress.

(v) Lack of Feedback and Perspective: Without external  feedback or perspective, self-motivated individuals
may struggle to accurately assess their progress  towards goals or identify areas for improvement.  This can
lead to a lack of growth or development,  as individuals may not receive the guidance or  support needed to
reach their full potential. 
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How file explorer helps in organizing files and  folders?

Question



AnswerAnswer
Here are three ways in which file explorer helps:  

(i) Navigating through files: File Explorer provides  an interface that allows users to easily navigate  through

files and folders on their computer.  

(ii) Searching for files and folders: This feature is  useful for quickly locating files that may be in  multiple

folders or sub folders.  

(iii) Sorting files and folders: This feature makes it  simple to locate and organise specific files or folders  in

a way that makes sense to the user. 



Mention differences between a file and a folder.

Question



AnswerAnswer
The differences between a file and a folder are  discussed below: 



Differentiate between CLI and GUI. 

Question



AnswerAnswer



Explain the regular maintenance schedule. Why is  it important?

Question



AnswerAnswer
Maintenance schedule is an important method to  ensure durability of a computer device along with  smooth
functioning.  

Daily maintenance:  
(i) Cleaning e-mail box and desktop of any unnecessary  files.  
(ii) Clearing the temporary files and data from the  computer  

Weekly maintenance:  
(i) Backing up important files and documents to cloud  storage or any other external storage.  
(ii) Updating the antivirus software and other  necessary security updates pushed by the software
manufacturer/provider.  



Monthly maintenance: 
(i) Cleaning the external peripherals like keyboard, mouse, screen to get rid of the dust and debris. 
(ii) Updating computer’s operating system, drivers, and software applications. 
(iii) Cleaning up storage space by deleting temporary files and delete files in the recycle bin. 

Yearly maintenance:  
(i) Cleaning the interiors of a computer or laptop  including the fans, power supply, and motherboard.  
(ii) Checking for any firmware updates.  
(iii) Replacing old peripherals with a new one. 



How we can prevent computer against attack by  viruses.

Question



AnswerAnswer
We can prevent the computer against attack of  viruses by installing proper antivirus, enabling the  firewall,
scan external devices before using on other  computer, by avoiding emails that are suspicious  or not known
to us, should be very careful while  downloading files or any programs from the  internet etc. 
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Explain any two functions of an entrepreneur. 

Question



AnswerAnswer
The following are the three functions of an  entrepreneur: 

(i) An entrepreneur must take decisions regarding his  business and take responsibility of the consequences. 

(ii) An entrepreneur must be innovative and always  ready to take risks to implement his innovative  ideas.  

(iii) An entrepreneur is responsible for dividing  his income wisely into various segments of his  business, even
if he faces loss he must pay for rents  and wages. 



Question

What leads to the degradation of an  entrepreneurial?



AnswerAnswer
There are several qualities that can degrade the  overall entrepreneurial skill which includes:  

(i) Entrepreneurship requires flexibility to respond to  shifting consumer demands and market conditions.  A
business failure and a decline in an entrepreneur's  skills can result from their inability to adjust and  change
their business strategy.  
(ii) While confidence is crucial for business success,  excessive confidence can result in poor judgment,
taking inappropriate risks, and ignoring  opportunities and challenges.  
(iii) Lack of resilience in an entrepreneur can cause  them to give up easily or lose motivation, which can
degrade their abilities and cause their company to  fail.  
(iv) To effectively manage the business, entrepreneurs  have to allocate tasks and responsibilities. Burnout,
stress, and a decline in skills can result from an  entrepreneur's inability to share tasks and attempt  to handle
everything themselves.  
(v) Time management is essential for entrepreneurs  in order to prioritize tasks, meet deadlines, and  achieve
their objectives. If an entrepreneur lacks  time management skills, he/she may struggle to  manage their
workload effectively, resulting in  a decline in their skills and the failure of their  business. 



Differentiate between myth and belief.

Question



AnswerAnswer



What are the myths about Entrepreneurship?  Explain any two: 

Question



AnswerAnswer
The myths about Entrepreneurship are:  

(i) Entrepreneurs are high risk takers.  They are neither high nor low risk – takers. They  always prefer
situations which lead to generating  profits.  

(ii) Entrepreneurs become rich as they start a new  business.  Starting a business does not mean that person
will  become rich overnight. A new business always  needs a span of year or two to become successful. 



Write advantages of pursuing entrepreneurship as  a career.

Question



AnswerAnswer
The advantages of pursuing entrepreneurship as a  career are as follows:  

(i) An entrepreneur is his own boss or owner and is  free to make all of his own decisions.  

(ii) Entrepreneurship can be very exciting, with many  entrepreneurs finding their ventures to be extremely
enjoyable. Every day brings new challenges to the  determination, skills, and abilities.  

(iii) By making goods and services available,  entrepreneurship primarily aims to improve  livelihood and
create wealth. Entrepreneurial  endeavors produce new wealth.  

(iv) Success in entrepreneurship boosts one's reputation  and status in society significantly.  

(v) One can realize their entrepreneurial dreams by  creating their own unique goods or Services. 



Green Skills-IIGreen Skills-II



Distinguish between organic farming and  conventional farming.

Question



AnswerAnswer



Explain the three primary goals of sustainable  development.

Question



AnswerAnswer
The three primary goals of sustainable development  are as follows:  

(i) Economic development: to promote economic  growth and create wealth while ensuring that  resources
are used efficiently and sustainably.  

(ii) Social development: to ensure that development  benefits all members of society, by promoting  equality
and social progress and by reducing  poverty, hunger, and inequality.  

(iii) Environmental protection: to protect the  environment by reducing pollution, mitigating the  effects of
climate change, and conserving natural  resources for future generations. 



How can we create sustainable cities?

Question



AnswerAnswer
Creating sustainable cities is a multifaceted task that  requires careful planning, investment, and

collaboration across multiple sectors. Some of the  ways are discussed below:  

(i) Green parks and green spaces should be developed  to improve air quality and lower city temperatures.  

(ii) By using energy-efficient lightings such as LED  bulbs and appliances we can promote energy

conservation.  

(iii) We should implement an efficient waste  management system which includes recycling,  reusing and

reducing the amount of waste  generated.



Discuss any five ways in which sustainable goals  can be achieved.

Question



AnswerAnswer
Sustainable development goals can be achieved  through concerted effort of every responsible  citizen. Some
basic ways in which people can help  to accomplish the goals of sustainable development  are discussed below:  

(i) Quality education: We must make quality education  available to all children while also lowering dropout  rates
among females in higher education.  

(ii) Clean Water and Sanitation: We should aim to  make India free of open defecation by building  toilets, take
measurable steps to provide clean tap  water and promote water conservation.  

(iii) Good Health and Well-being: We should improve  access to quality health care, promote healthy  lifestyles,
and raise awareness about mental health  services.  

(iv) Affordable and Clean Energy: We should ensure  affordable, reliable and sustainable energy for all.  We
should shift from fossil fuels to clean energy  sources such as hydrogen fuel.  

(v) Gender Equality: We should promote gender  equality and empower all women and girls. We  should try to
eliminate all forms of discrimination  and violence against women.



Why do you think the United Nations has made  the 17 Sustainable Development Goals? 

Question



AnswerAnswer

The United Nations adopted the 17 Sustainable  Development Goals (SDGs) to address the world's  most
pressing issues and encourage long-term  development. The SDGs were approved in 2015 by  all UN member
states as part of the 2030 Agenda for  Sustainable Development, which is a plan of action  for people, the planet,
and prosperity.  
The Sustainable Development Goals (SDGs) are  an answer to the interconnected problems that  the world is
battling, such as poverty, inequality,  climate change, environmental degradation, and  social and economic
exclusion. The SDGs are also  founded on universality, the concept of leaving no  one behind, and a commitment
to human rights.  
They apply to all countries and people, and they  aim to guarantee that everyone has the chance  to live a life of
dignity and fulfilment while also  protecting the planet and its resources for future  generations. 
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Elaborate four different types of styles which can  be provided in a Word Processor. 

Question



AnswerAnswer
Paragraph styles control all aspects of a  paragraph’s appearance, such as text alignment, tab  stops,

line spacing, and borders, and can include  character formatting.  

Character styles affect selected text within a  paragraph, such as the font and size of text, or bold  and

italic formats.  

Cell styles include fonts, alignment, borders,  background, number formats (for example,  currency,

date, number), and cell protection.  

Graphics styles in drawings and presentations  include line, area, shadowing, transparency, font,

connectors, dimensioning, and other attributes. 



Write the steps to create a new style from the  selection.

Question



AnswerAnswer
To Create a New Style From a Formatted Selection  follow the given below steps:  

i. Choose View -> Styles to open the Styles pane in  the Sidebar. 

 ii. Click the icon at the top of the Styles deck for the  style category of the new style.  

iii. Click in the document where you want to copy the  style from, for example, in a paragraph to which  you

applied manual formatting.  

iv. Click the Style actions menu icon at the top right  corner of the Styles deck and choose New Style  from

Selection from the submenu. 



v. Enter a name for the new style. 

vi. Click OK. 



What is the utility of text wrapping in a document? 

Question



AnswerAnswer
Text wrapping refers to the relation of graphics to  the surrounding text, which may wrap around the
graphic on one or both sides, be overprinted behind  or in front of the graphic, or treat the graphic as a
separate paragraph or character 



Write the steps to create a template from a  document.

Question



AnswerAnswer
Steps to create a template from a document:  

i. Open a new or existing document.  

ii. Add the text that you want to display in the  document you create from the new template.  

iii. Select any style that you want to use in the new  template.  

iv. On the Menu bar, choose File ---> Templates --->  Save as Template.  The Save as Template dialog

opens. 

v. Select a category and type the name.  

vi. Click Save. 



Write the steps to customize a table of contents. 

Question



AnswerAnswer
You can customize the table of contents to suit the  style and requirements of your document.  
Follow the given below steps to customize a table  of contents  

i. Click in the document where you want the table of  contents to appear.  

ii. Now, select Insert → Table of Contents and Index  → Table of Contents, Index or Bibliography to open  the
Table of Contents, Index or Bibliography dialog.  The Table of Contents, Index or Bibliography dialog  has five
tabs as shown. Each tab has different  characteristic of the TOC structure and appearance.  

Set the attributes of the TOC in the Type tab.  
Set the style of paragraph in the Styles tab.  
Format the entries in the Entries tab.  
To put the TOC into more than one column use  the Columns tab.  
To add color or an image to the background of  the TOC, select the Background tab. 

iii. Now select the preview box, located on the righthand side of the dialog, to check how the TOC will  appear. 

iv. After making all your changes, click OK to apply  them. 



Briefly describe table of contents. 

Question



AnswerAnswer

Tables of contents  
The Table of contents feature allows to build an  automated table of contents from the headings  in your
document. The entries for the table are  automatically generated as hyperlinks. Whenever  changes are
made to the text, those changes are  applied automatically in the table of contents when  it is next updated. 



Write the steps to resize the image.

Question



AnswerAnswer

To fit the image into the document, you may have to  resize it.  

(1) Click the image to show the sizing handles.  

(2) Position the cursor over one of the sizing handles. 

(3) Click and Hold left buttons on Mouse and drag to  resize the image.  

(4) Release the mouse button when done. 
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Write the steps to apply the multiple operation  tool. 

Question



AnswerAnswer
Applying Multiple Operations:  

(i) Create the following table.  

(ii) Enter the alternative values to calculate as shown  below.  

(iii) Select Multiple Operations form the Data tab.  

The Multiple operations dialog box appears. 

(iv) In Multiple Operations, select the formula, and  select values to be changed.  

(v) Now, click on OK to get the interest based on  different principal. 



When solver is used? 

Question



AnswerAnswer

A solver is used to solve equations with multiple  variables by using the goal-seeking method.  
You can choose whether the value in the target cell  should be a maximum, a minimum, or approaching  a
given value.  
The initial variable values are inserted in a  rectangular cell range that you enter in the By  changing cells
box.  
You can define a series of limiting conditions that  set constraints for some cells. For example, you can
set the constraint that one of the variables or cells  must not be bigger than another variable, or not
bigger than a given value. 



Differentiate between Relative and Absolute  Hyperlinks with the help of an example. 

Question



AnswerAnswer



Write the steps to merge documents.

Question



AnswerAnswer
Sometimes you need to make a single document  from multiples edited documents. You can review  all
the comments in one document from different  people and check their comments, rather than one
review at a time. For this purpose, you can merge  documents in Calc.  

To merge documents, follow the below given  steps:  

i. Open the original document.  

ii. Select Edit > Track Changes > Merge Document on  the Menu bar. 

iii. A file selection dialog opens. Select a file you want  to merge and click Open.  



iv. After the documents merge, the Manage Changes dialog opens, showing changes by more than one
reviewer. If you want to merge more documents, close the dialog and then repeat steps 2 and 3. Now all
of the changes are combined into one document and you can accept or reject the changes. Changes
from different authors appear in cells outlined in different colors.



How cal finds the changes done in a document if  Track changes is not enable?

Question



AnswerAnswer
Calc finds and marks the changes as follows:  

All data that occurs in the edited document but not  in the original is identified as inserted.  
All data in the original document that is not in the  edited document is identified as deleted.  
All data that is changed is marked as changed.  Here, you can accept or reject changes. 



Mention any two operations that can be performed  using Macros in a spreadsheet. 

Question



AnswerAnswer
Macros are used to perform different types of  operations in a Spreadsheet:  

i. Formatting settings to be applied repeatedly in a  spreadsheet  
ii. Sorting Data  
iii. Applying any Mathematical functions/formulas 
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What is DBMS? Explain any two advantages of  DBMS.

Question



AnswerAnswer
A database management system is a software  package with computer programs that controls the
creation, maintenance, and use of an integrated  collection of data records, files, and other objects.  It
allows organizations to conveniently develop  databases for various applications. 

Advantages:  

(i) Data integrity: means the data is accurate and  consistent in the database. It is very important as
there are multiple databases in a DBMS so it helps  to produce the correct result.  

(ii) Data sharing: In a database, the users can share  the data among themselves. Data can be shared
for multiple purposes with the users located at  different geographical locations. Remote users can  also
access the database simultaneously. 



What are the types of data types?

Question



AnswerAnswer

The common data types used in LibreOffice along  with their descriptions are given below:  
Memo [LONGVARCHAR]: It is used to store a  large amount of text, such as a description field.  
Text [VARCHAR]: It is used for a short string of  text, such as names or addresses.  
Yes/No [BOOLEAN]: It allows to enter Boolean  values yes or no.  
Time [TIME]: It is used to store the hours, minutes,  and seconds. The format of the date can be set
in  the table design view.  
Date [DATE]: It is used for storing calendar dates.  The format of the date can be set in the table
design  view.  
Decimal [DECIMAL]: It is used to define the fields  that store values with numbers having decimal
places. 



Write applications of DBMS.

Question



AnswerAnswer
Let us look at some of the areas where database  applications are widely used to store, manage and
retrieve data.  

Schools: It can be used to store the student records  with their personal information and parent’s
details. It can also be used to keep a record of the  fee and result details.  
Airlines: It is used to maintain a record of passenger  details, flight schedule, reservation or cancellation
status.  
Hospitals: It helps to maintain a record of patient’s  medical history and the treatment provided for the
same.  
Banks: It helps to store and retrieve and  query customer’s account information such as  withdrawals,
deposits, payments and loans.  
Telecommunication: It helps to keep a record of the  calls attended, missed, calls duration and monthly
bills. 



Explain relationships and their types.

Question



AnswerAnswer
A relationship in Base refers to an association  between two or more tables. Relationships between  tables
helps in saving time as there is no need to  enter the same data in another tables. If there is a  large amount
of data that you need to display in a  table, in that case, you can store data in more than  one table. To
display the data from more than one  table as a single table, you must create relationships  between the
tables. Relationship can be established  by matching the fields with the same name in  different tables. For
example, you can create a  relationship between two tables, if one field serves  as a primary key in one table
and the same field  serves as a foreign key in the second table.  

Types of Relationship
There are mainly three types of relationships that  you can establish between two tables.  

One to One: In this type of relationship a record in a  table can have only one matching record in another
table. One-to-One relationship can be established  when two tables are related by a single row.   



One to Many: In this relationship, one record in one  table is associated with many records in the second
table. This type of relationship can be established  where one record in a table matches with many
records in another table. For example, a same  employee can do multiple tasks in an organisation  or a
students is doing many activities in a school.  

Many to Many: In this type of relationship, many  records of a table matches with many records of
another table. This type of relationship can be  established when many records in a table are  associated
with many records in another table. 



Consider the following Vendor table and write the  queries 

Table Vendor 

Question

(i) Write a Query to display all records  
(ii) Write a Query to add a new row with the  following details  ('V005', Vadilal', '2010-03-20', 'Pune')  
(iii) Write a query to modify the location of V003  from Kolkata to Gujarat  Update Vandor  
Set location = 'Gujrat'  
Where location = 'Kolkata'. 



AnswerAnswer

(i) Select * from Vendor;  

(ii) Insert into Vendor valves ('Voo5', 'vodilal',  '2010-03-20', 'Pune');  

(iii) Update Vendor  Set location= „Gujrat"  Where location= „Kolkata"; 



Write the steps to search the records in a form.

Question



AnswerAnswer
To search a record using form, follow these steps:  

(i) Click on Find Record button from the navigation  toolbar. A new dialog box appears with the title  “Record
Search”.  

(ii) Type text you want to search in the search for option  and in the box available at the front of Text.  

(iii) Select the fields whether all the fields or single field  from the box. Apply the desired settings and click
on search button.  

(iv) Now the record that you have searched, will be  displayed on the screen. 



Define the following:  
(a) Data Integrity  
(b) Data Inconsistency  
(c) Composite Primary Key  
(d) Relationship (with respect to DBMS) 

Question



AnswerAnswer
(a) Data Integrity: Data Integrity is very important  as there are multiple databases in a DBMS. It  means that
the data is accurate and consistent in  the database.  

(b) Data Inconsistency: Data inconsistency is  when the same data exists in different forms in  multiple
tables. Which can provide a unreliable  or meaningless information.  

(c) Composite Primary Key: It is also called a  composite key. It is a combination of two or more  columns to
form a primary key for a table  

(d) Relationship: A relationship refers to an  association or connection between two or more  tables. When
we relate two tables, we don't need  to enter the same data in separate tables.  
Three types of relationships are: 



 
(1) One to One relationship 
(2) One to many or many to one relationship 
(3) Many to many relationships
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Write any four safety rules of fire safety.

Question



AnswerAnswer
Preventive Measures of Fire Safety  

i. Installing fire Alarms: All businesses are required  by law to install fire alarms. While some alarms may  go
off automatically, if they're manual, make sure to  teach staff members how to use them.  

ii. Emergency plan: This should include information  on what staff members must do in the event of  a fire,
the kinds of warning systems in use, and  evacuation protocols.  

iii. Create fire escape routes: They must have visible  signage, be well-lit, and direct visitors to a secure
location. To make sure your fire escape routes are  successful, plan them in line with the local fire  authority.  

iv. Designate a Specialised Person: A person or  persons should be in charge of overseeing fire  safety at
your place of business and helping with  evacuations in the case of a fire. They are referred  to as fire
wardens. 



What are the various types of accidents?

Question



AnswerAnswer

Types of Accidents at the Workplace  
The following are different types of the accidents at  the workplace:  

i. Falls and Slips: Slips and falls are the most frequent  accidents at work. Employees may sustain a variety
of injuries as a result of slips, trips, and falls.  

ii. Fire: Explosions and fire are both harmful and  occasionally fatal. It causes huge damages to
organizations.  

iii. Road Traffic accidents: An accident involving two  or more automobiles on a public highway or road  that
leaves many people injured or dead.  



iv. Clinical Negligence: It refers to suffering or injury brought on by a doctor's inadequate or nonexistent
treatment. It might be bodily or emotional injury. 

v. Sports related accidents: Physical activities frequently result in injuries. An injury sustained while
participating in sports, exercise, or other athletic activities is referred to as a sports injury. 



Write preventive measures of hazards.

Question



AnswerAnswer
Following are the preventive measures of hazards:  

make sure that your personal hygiene poses no  risk to others in order to achieve the complete
eradication of all potential risks when working with  others.  
Respond appropriately in the event of an accident,  damage, or injury.  
Look for crowds at your place of employment.  
Use established methods while being closely  supervised when performing potentially hazardous  job.  
Employ proper handling and movement practices.  
Observe hygienic practices.  
To deal with emergencies, put on protective  clothing.  
Handle spills and dispose of trash while using and  storing tools and supplies securely. 



What is the importance of healthy lifestyle? Give  any four points related to it.

Question



AnswerAnswer
A healthy lifestyle helps to keep and improve  people’s health and well-being. 
A healthy lifestyle  includes:  

(i) Healthy eating habits.  
(ii) Physical activities.  
(iii) Stress management  
(iv) Sound sleep 


